
Use without a mouse 

Powerful keyboard shortcuts 

Icons, buttons, and windows 
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The following sections (Basic Mouse Techniques, Buttons, Windows, The 
Browse the Service Window, Using the Menu Bar, and Keyboard Shortcuts) 
will teach how to use America Online effectively with a mouse and/ or a keyboard. For 
your convenience, both keyboard and mouse instructions are provided. 

BASIC MOUSING 
TECHNIQUES 

Point and Click 
A mouse is a device that allows a user to select and ma
nipulate objects on a computer screen. On your screen 
you see an arrowhead ( + ) that mirrors the movement 
of your mouse. This arrowhead is known as a mouse 
pointer. Position your mouse pointer on an object on 
your screen (e.g., a button), then click on the left mouse 
button. 

America Online uses the left mouse button 
only. 

Certain actions require double-clicking: for example, 

• using the window operator to close a window; 
• launching America Online using an icon; 
• maximizing a window after minimization; 
• opening a folder; 
• going back to a folder. 
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Dragging 
With your mouse, you can also drag objects around the 
screen. For instance, to drag a window, place your mouse 
pointer on the title bar (see Windows on page 6) of the 
window. Hold down the mouse button and drag the win
dow and the mouse to the desired area of the screen. When 
you have the window where you want it, release the mouse 
button. 
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BUTTONS 

A button is an object on your screen that performs the 
action written on it. Buttons are either selectable (which 
means they are currently available for use) or inactive 
(which means they are not currently available for use). 

Using a Mouse: 
To select a button using the mouse, place the mouse 
pointer on the selectable button of your choice and click. 
(Figure 1 illustrates selectable versus inactive buttons.) 

Using a Keyboard: 
For keyboard users, selectable buttons (see Figure 1) are fur
ther defined into two states: current and default. A current 
button is the button that contains the cursor. You can 
move the cursor by pressing Tab . Whatever button con
tains the cursor becomes the current button. From the key
board, it is activated by pressing the Spacebar. A default 
button is the button that is activated if you press the Enter 
key without selecting another button. 
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Buttons can have multiple states or can change states, depend
ing upon your selections. For example, a default button is a 
selectable button and can also be the current button. Or a se
lectable, current button can become just a selectable button if 
you press the Tab key. 

Button State Description 

Figure 1. Button States 

Selectable Any active button (i.e., not 
dimmed) 

Current Action chosen if you press 
the spacebar (i.e., contains 
the dotted-line cursor) 

Default 

Inactive 

The default action (i.e ., 
enclosed by a rectangle) 

Not currently available (i.e. , 
dimmed) 
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WINDOWS 

A window (see Figure 2) is a portion of your screen dedicated 
to some specific purpose. A screen can contain multiple win
dows. A given window may contain a title bar (which usually 
indicates the topic of the information contained in the win
dow), a window operator (which closes the window), and a 
scroll bar (which enables you to move text up and down in the 
window). A current list of active windows is under the Win
dow Menu. To move from one active window to another, 
select the name of that window in this menu. For more infor
mation on the menu bar, see Using the Menu Bar on page 12. 

Scroll 
Arrows 

Figure 2 . A Window 

Scrolling 
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Slider Box 

Scroll Bar 

If the area beneath the slider box is dimmed, there is more in
formation to be seen; therefore, you must scroll to see the rest 
of the information. You can do this in a number of ways. 
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Using a Mouse: To scroll up continuously .. .. ... Click on the top scroll arrow. 
To scroll down continuously ... Click on the bottom scroll arrow. 
To scroll to an area .. ... ... ... ..... .. Drag the slider box until you 

have reached the desired area. 
To scroll up a page .... ... ....... ... .. Click above the scroll box. 
To scroll down a page .. .. ..... .... . Click below the scroll box. 

Using a Keyboard: To scroll up a page .... ... .. .... ...... Press the Page Up key. 
To scroll down a page ....... .. ..... Press the Page Down key. 

Re-sizing a W indow 
Windows with double borders can be re-sized. To re-size a window, 
place the mouse pointer on the comer of a window so that the 
mouse pointer changes into an arrow. Hold down the mouse 
button, and drag the outline of the window to the desired size. 
Then, release the mouse button. 

Moving a Window 
There will be many times that you want to move a window so that 
you can see the contents of more than one window. To move a 
window, place the mouse pointer on the title bar of the window, 
and hold down the mouse button. Drag the window, to the desired 
area, and release the mouse button. 

Closing a Window 

Using a Mouse: To close a window, double-click the window operator (see Fig. 2) . 

Using a Keyboard: To close a window, press the Ctrl and F4 keys at the same time. 
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THE "BROWSE THE 
WINDOW SERVICE" 

America Online is rich with options in the various departments. 
To help you keep track of where you are, the Browse the Service 
window tells you what path you have taken so far (What You 
Have Selected) and what options are ahead of you (What You 
Can Select). It's a handy roadmap of where you are in America 
Online. 

What's _ 
Behind 
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Figure 3. The Browse the Service Window 

Accessing the Browse the Service Window 

Using a Mouse: 

_ What's 
Ahead 

• When the America Online Welcome window appears, 
click the Browse the Service button. 

Using a Keyboard: 
• When the America Online Welcome window appears, 

press the Enter key. 
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Entering an America Online Department 

Using a Mouse: 
• Click the department icon of your choice in the Browse the 

Service window. 

Using a Keyboard: 
1. When you enter the Browse the Service window, the cursor is 

on the News & Finance icon. Tab to advance to the depart
ment icon of your choice. (Make sure you watch the cursor 
move from icon to icon.) 

2. When the cursor is on the department icon of your choice, 
press the Spacebar. 

The What You Have Selected: list box lists the title of the depart
ment you selected, and the What You Can Select: list box fills with 
all the areas that are ahead of you. 

Pressing the Tab and Shift keys at the same time moves the 
cursor in the opposite direction. 

Entering an Area of a Department 

Using a Mouse: 
• Double-click the title of an area in the What You Can Select: 

• list box. 
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Using a Keyboard: 
1. When you have selected a department, the cursor appears 

on the topmost area in the What You Can Select: list 
box. 

2. Press the Up or Down Arrow key to move the cursor from 
area to area in the list box. 

3. When the cursor is on the desired area, press the 
Space bar. 

4. To continue down a path of areas in one department, 
simply repeat Steps 2 and 3. 

Going Back to an Area of a Department 

Using a Mouse: 
• Double-click the title of an area in the What You Have 

Selected: list box. 

Using a Keyboard: 
1. Tab until the cursor appears in the What You Have 

Selected: list box. 

2. Press the Up Arrow key to move the cursor to the area to 
which you would like to return. 

3. When the cursor is on the desired area, press the 
Space bar . 
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For a detailed description of the Browse the Service window, access 
Get Help in the Help Menu, and read Browse the Service Window. 
If you do not know how to access the Help Menu, please read Using 
the Menu Bar on page 12. 
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USING THE MENU BAR 

The America Online menu bar (see Figure 4) gives you added func
tionality so that you can use the service powerfully and easily. It has 
seven menu items: Help, File, Edit, Go To, Mail, Members, and 
Window. Each menu item has a list of options that appear under the 
menu when the menu item is selected. For instance, when you select 
the Edit Menu, the Cut, Copy, and Paste options appear. 

Menu~~~~~~~~~!!l'!!~~~~~~~:J 
Bar 

Mail Menu 
Options 

Figure 4. The Menu Bar 

Pulling Down a Menu 

Using a Mouse: 

Keyboard 
Shortcuts 

• To use the menu bar, place the mouse pointer on the menu 
item of your choice, and click the mouse button. 

• The list of menu options appears. Click the desired menu 
option. 
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Using a Keyboard: 
The menu bar appears at the top of the America Online window. The 
Help, File, Edit, Go To, Mail, Members, and Window Menus appear 
with an underlined letter: for example, file. To pull down a menu, fol
low the steps below: 

1. Press the Alt key and the underlined letter from the menu of your 
choice. 

2. A rectangle appears around the menu item you selected. Press 
the Down Arrow key to move the rectangle to the menu option 
of your choice. 

3. Press the Spacebar to choose the menu option. 

Most menu options a~ with an underlined letter and a keyboard 
shortcut (see Figure 4). To use the keyboard shortcut, press the desig
nated combination of keys at the same time; for example, press the 
Ctrl and F4 keys at the same time to dose a window. To perform a 
menu option from the keyboard using the underlined letter, pull down 
the desired menu, then press the underlined letter and the Aft keys at 
the same time; for example, press the Alt and C keys at the same time 
to dose a window. Keyboard shortcuts are provided on page 14. 

Canceling An Action 

Using a Mouse: To cancel an action, select Cancel Action from the File Menu. 

Using a Keyboard: To cancel an action, press the Ctrl and X keys at the same time. 

An hourglass on your screen means the system is currently busy and 
cannot accept any commands other than Cancel Action. 
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KEYBOARD SHORTCUTS 

The list of key combinations below will help you become more efficient. 
Simply press the key(s) in the right column to perform the command in 
the left column. 

Cancels an action ...... .. .. .... ..... .. .. ...... ... .. .. ...... ....... ... .. Ctrl and X 
Closes a window .. .. ...... ... ..... ..... .. .... .. .... .... .. .... ...... .. ... Ctrl and F4 
Copies ...... ...... .. .... ... ...... .. ... .... ... ... .. ... .. ... .. .................. Ctrl and Ins 
Cuts .. .. ................ .... .... .. .. .. ......... .. ... ... ... .. ...... .. ... .. ... .... Shift and Del 
Displays new mail .... .. ................. .. .. .. .... .. .. .. .. .... ......... Ctrl and R 
Finds a member online ..... .... .. .... .. .. .. .. ... ..... .... .. ......... Ctrl and F 
Full sizes Browse the Service window ...... ................ Ctrl and FlO 
Gets member info .. .......... .... .................... .... ... .. .... .. ... Ctrl and G 
Moves cursor in opposite direction .. .... .. .. .. .. ........ ... .. Shft and Tab 
Moves cursor ... .. ............ .. ..... .... ......... ...... .. ... .. ... .. .. .... . Tab 
Opens a new text file ... .... .. .. .. ............ .. .. ..... ........ .. .. .. . Ctrl and N 
Opens an existing file .. .... ... .... .. .. ...... ......................... Ctrl and 0 
Opens Browse the Service window ..... .. .. ....... .... ...... Ctrl and D 
Opens Keyword window .. .. .............. ........ ... .... .... ... ... Ctrl and K 
Opens Lobby window ...... .. ... .... ....... .... .. .. ... .... ........ .. Ctrl and L 
Opens Mail window ....... ........ ... ... ... .. .. .. .... .. .............. Ctrl and M 
Overlaps Browse the Service window .. .. ............ .. .... Ctrl and FS 
Pastes .... ........ .. ...... .. .. .... ............................................. Shft and Ins 
Prints .... .. .... .... .. .. .... .. ........ .. ..... ...... .... ..... .. ..... .. ... .. ...... Ctrl and P 
Saves a file .... .. .. ....... .. .. .. ...... .. ... ... .. .. ... ......... ......... ...... Ctrl and S 
Sends an instant message ........ ........ .. ...... ....... .... ....... Ctrl and I 
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